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CHAPTER II 

LITERATURE REVIEW 

 

 

2.1. Print Media and Electronic Media 

 According to Arsyad (2011), the word media comes from the Latin medius 

literally means middle, intermediary or introduction. In Arabic, the media is an 

intermediary or the introduction of the message from the sender to the recipient of 

the message. Where does it say that as long as the media is widespread, whether 

human, material, or causal, it creates conditions that prepare students to acquire 

information, skills, and dispositions.  

 Media can be classified into two categories, namely print media and 

electronic media. Print media consists of written sources such as newspapers, 

magazines, books, booklets, etc. While electronic media consists of television, 

radio, and the internet such as e-booklets. Recently, the rapid development of the 

internet has even become the driving force behind the birth of various forms of 

electronic media. Blogs or websites, it has even become an alternative medium for 

disseminating information more quickly without being dependent or limited by 

the problem of time and place. 

 Kasali (2007) said print media is static media and prioritizes visual messages. 

This media consists of sheets with a number of words, pictures, or photos, in color 

and white pages. In addition, Surya (2012) said electronic media is information or 

data that is created, distributed, and accessed by using an electronic form, electro-

mechanical energy, or other means used in electronic communication. Included in 

electronic media are television, radio, computers, mobile phones, and other 

devices that send and receive information using electronics. 

 It can be concluded that the media is divided into two, namely print media 

and electronic media. Print media is a written source while electronic media are 

all media devices that use electro-economic energy for users to access content. A 

simpler definition of electronic media is all information or data that is created, 

distributed, and accessed using electronic forms. 
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2.2.  Booklet 

 According to Gustaning (2014) :  

“Booklet adalah buku berukuran kecil (setengah karto) dan tipis, tidak 

lebih dari 30 lembar bolak balik yang berisi tentang tulisan dan 

gambar-gambar. Istilah booklet berasal dari buku dan leaflet artinya 

media booklet merupakan perpaduan antara leaflet dan buku dengan 

format (ukuran) yang kecil seperti leaflet”. 

 It can be conclude that booklet is a small book, no more than 30 pages that 

contains about pictures and writing of certain topic. Booklet is also a combination 

between the leaflets and books with a small size format. Moreover, Gustaning 

(2016) stated that, “Booklet adalah media komunikasi yang bertujuan untuk 

menyampaikan pesan berupa saran promosi, larangan ke masyarakat umum, dan 

dibuat dalam bentuk media cetak”. It means that booklet is a media to 

communicate that aims to promotional suggestion, prohibitions to the public, and 

in the form of print. Booklet is an alternative media counseling that provides 

effectiveness and effeciency in the results and extension process. 

 While as claimed by Simamora (2009) booklet is a small book and thin, no 

mo 

re than 30 sheets of back and forth containing writing and pictures. The term 

booklet is derived from the book and leaflet means media booklet is a 

combination of leaflet and book format (size) as small as a leaflet. The structure of 

the booklet's contents resembles book (introduction, content, cover), it's just a way 

of presenting its contents much shorter than a book.  

 From the explanation above, it can be said booklet is a small book, no more 

than 30 pages that contains about picture and writing with the purpose are to do 

promotion and give suggestion. Booklet also possible to be stored, read over and 

over, and shared with others. 

 

2.2.1. How to Design Booklet 

  In order to make a good booklet, there are some steps according to 

Weedmark (2015), design booklets can be done using Microsoft Publisher 
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program. The following steps of making a booklet through Microsoft Publisher  

program: 

1. Selecting a Booklet Page Design  

- Open a blank publication. Click the Page Design tab and then click the Size   

icon. Select More Preset Page Sizes at the bottom of the drop – down menu.  

-  Click the Booklets folder. Other folders contain other page sizes.  

- Select any booklet that suits the project. For a booklet made from letter – 

sized paper that is folded in landscape mode, select the first 1/2 Letter 

Booklet option, which has page sizes of 5.5 by 8.5 inches. This booklet 

generates four pages per sheet of paper. The first and the fourth page are 

printed on one side of the sheet, with the second and third pages on the other 

side so when folded the sheet in half, the four pages can be read in order. 

2. Adding Text to the Booklet 

- Click the Insert tab and then click the Draw Text Box icon. Drag the cursor 

over the first page to make the title appear. If align the text box perfectly over 

the margins after releasing the mouse button. This behavior is normal and it 

ensures that the text inside the text box will be aligned with the page margins. 

- Type or paste the title in the text box. Highlight the text by dragging the 

cursor over every letter to format it. Click the Home tab and select a Font, 

Font Size and Alignment for the title.  

- Draw text boxes on each of the other pages. Begin typing the content for the 

booklet in the first text box after the title or paste it from another document. 

When there is too much text for the box, an Overflow Indicator appears on 

the border. Click the Overflow Indicator again to link it to the third, then link 

the third text box to the fourth until the four – page booklet is filled.  

- Highlight all of the text by clicking the first text box containing the booklet’s 

content and pressing Ctrl + A. Click the Home tab and format the text as 

desired. To use headings in the booklet, highlight the heading and then select 

a style from the Style icon in the Home ribbon. 

3. Adding Images to the Booklet  
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- Add images from your computer by clicking the Insert menu and then 

clicking Pictures. To find images using Bing Image Search, click Online 

Pictures.  

- Drag any corner of the image to resize it without distorting its aspect ratio. To 

move an image, just drag it until it appears.  

- Right – click the image and click the Text Wrap icon to adjust the way text 

wraps around the picture. By default, Text Wrap is enabled, but that makes 

the image appear beneath the text, over the text, or have it in – line with the 

text. 

4. Printing the Booklet  

- Click the file tab when the booklet is ready to print. Select Letter – sized 

paper in the Settings section and then examine each page in the Preview 

window. Click the Arrow beneath the preview to examine other pages. 

 

2.2.2. Criteria of a Good Booklet 

 There are criteria of a good booklet according Howard (2014), as follow: 

1. Booklet seems like books but generally it is smaller and its page usually only 

from 4 – 48 pages. 

2. A typical booklet style is a stack of 2 or more sheets of letter size paper, folded 

in half. 

3. The number of pages is always divisible by 2, such as 2 pages, 4 pages, 8 

pages, etc. 

 

2.2.3. Booklet Writing Requirements 

 As claimed by Rahayu (2014) that there are several things that need to be 

considered. The requirements include: 

 1. Use doc or docx format. 

 2. Use Calibri font and with size 12 pt. 

3. Use the Calibri letters for picture or table description, with size of 9 pt, and the 

picture description does not use numbers. 
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4. Use color of the black font, with text 1, is 25% lighter (this position is in a 

Slightlygray but almost black area). 

5. Use distance of 1 space between paragraphs is given a distance of 6 pt, and the 

length of writing, a maximum of 7 A4 pages. 

 6. Use good and correct Indonesian, easy to understand, and simple. 

7. Use references, listed as reading material, whether sourced from an internet link 

(making it more accessible) or textbooks. Reading material can be quoted in 

writing. 

8. Use biography, contains brief information of the author, including work and 

affiliation, and it is recommended to enter an email address. 

 

2.3. E-Booklet 

 In the opinion of Yandri (2016), E-Booklet is an information media that aims 

to deliver a message in electronic form, so that people can understand and know 

the message contained in it. So, it will give specific information, and society 

prefers searching for information on electronic media nowadays. Because 

electronic media is more practical, can be accessed more quickly, most of people 

already have access from internet, and can be read anywhere and anytime by the 

local society or even international society. According to Fuad (2016), e-booklet 

have various types of file formats, including PDF (Portable Digital Format), 

EPUB (Electronic Publication) which is a format formed by international open 

forums, Digital Publishing Forum (IDPF), (AZW (Amazon Word), MOBI 

(MobiPocket) and PRC (Product Representation Compact). 

 E-Booklet (Electronic Book) is a digital form of a booklet and includes 

electronic based media. Electronic-based media has several main characteristics, 

namely the material is concise, attractive and easy to understand, equipped with 

lots of pictures, videos and sound recordings (Fatimah & Mufti, 2014; Asyhari & 

Diani, 2017). To make the reader easy to understand, it needs effective sentences. 

According to Widjono (2012) effective sentences are short, concise, clear, 

complete and can convey the information precisely, etc., because ineffective 

sentences will affect the perfect writing. 
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 E-Booklet are more compact than printed booklet. Users of smartphones and 

other handheld devices can open the E-Booklet anytime and anywhere. E-

Booklets are more durable because they are digital, so they are less easily 

damaged than printed booklets. E-Booklets are more environmentally friendly 

than regular booklets because they don't require ink and paper. 

 

2.3.1. Effectiveness of Using E-Booklet 

 The modern era at this time provides an opportunity for humans to live 

instantaneously. There is no exception for services in promotions that make it 

easy to be able to store books practically without having to carry heavy loads and 

take up space, namely with the existence of electronic books (e-books) all can use 

them whenever and wherever the user is. This is in line with the statement, 

(Putera, 2011) which says that e-booklet is a technology that utilizes computers to 

display multimedia information in a concise and dynamic form. Similarly, 

(Woodburn, 2008) states that E-Book allows a user to find information much 

more quickly, you could spend years looking for a single name in a physical 

library, but seconds searching across that same library in electronic form. 

 Through the explanation above, it has an understanding that the effectiveness 

obtained from electronic textbooks is digital enhancement and interactive web 

links that have been provided by publishers in electronic textbooks so that 

electronic books can be accessed more for reading material and can be interpreted 

as an E-Book that provides an opportunity for users to be able to find information 

faster. 

 

2.4. Media Electronic Relations with Tourism 

 The development of the tourism industry involves various stakeholders. 

Tourists include the most essential and main stakeholders in the tourism industry. 

Travelers are industrial demand sides. Hospitality and restaurant owners act as 

suppliers for tourists. Travel agencies act as an intermediary that connects the 

demand side with suppliers. The planning body at the regional level, state, and 
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national formulate and implements tourism-related policies. It can be ascertained, 

that digitalization affects each stakeholder in the tourism industry. 

 In the opinion of Costa (2020) electronic media allows companies to attract 

and engage customers and suppliers together to improve communication strategies 

in promoting relationships among stakeholders that transcends distance and time. 

Moreover, according to Rumondang (2020), market figures show that consumers 

are switching purchases to online stores, including in the behavioral journey of 

customers who are starting to leave offline methods, including in tourist trips. 

 It can be conclude that electronic media is a process that uses digital 

technology as a tool to acquire customers, build customer preferences, promote 

brands, retain customers and increase sales. Electronic media serves as the key to 

success for capturing new business possibilities by changing existing business 

processes, such as communications, distribution, or tourism business 

management. 

 

2.5.  Traditional Food 

 Kwik (2008) in his book stated that,  

“Makanan tradisonal adalah makanan, minuman, makanan jajanan 

serta bahan campuran yang digunakan secara tradisional dan telah 

lama berkembang secara spesifik di daerah atau masyarakat 

Indonesia. Biasanya makanan tradisonal diolah dari resep yang 

sudah dikenal oleh masyarakat setempat dengan bahan-bahan yang 

diperoleh dari sumber lokal yang memiliki citarasa yang sesuai 

dengan seleranya”. 

 Summarizing, it can be assumed that, traditional food is a system of find 

indigenous people that can be defined as items that are from the local, natural 

environment that are culturally acceptable. It also includes the sociocultural 

meanings, processing techniques, use, composition, and nutritional consequences 

for people using the food. 

 In a similar manner, Endang (2013) said that traditional food is a form of 

culture that is characterized by regional, specific, diverse types that reflect the 
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natural potential of each region. Food is not only a means to meet one's nutritional 

needs. Food is also useful for maintaining human relations, a symbol of the 

identity of a particular society, and can also be sold and promoted to support 

tourism that can support a region's income. 

 Overall, it may be said that that traditional food is anything that can be eaten 

that comes from an area and is only owned in the area so that it can become a 

characteristic for the area, processed according to food recipes that have been 

known for techniques and cooking utensils handed down from generation to 

generation. 

 

2.5.1. Types of Traditional Food 

 There are many kinds of traditional Indonesian food, based on their level of 

existence in society today. The diversity of traditional foods that exist is 

influenced by the conditions of the area or place of residence and the culture that 

exists in the area. With the diversity of traditional foods in an area, not a few 

traditional foods are almost forgotten by today's society.  

 According to Murdijati (2017), traditional foods can be categorized into three 

groups: 

1. Traditional food that is almost extinct. 

This traditional food that is almost extinct is rare and can hardly be found, 

maybe because the availability of basic ingredients is getting difficult or the 

people who make it are starting to stop working or are pressured by other food 

products. Examples include cethot, entog-entog, brittle, es semlo, and hawuk-

hawuk. 

2. Less popular traditional food 

Traditional food groups that are less popular are traditional foods that are still 

easy to find, but are increasingly unknown and tend to have fewer fans, are 

considered to have lower social status in society. For example, kethak, adrem, 

wedang tofu, lemet, bothok sembukan, and bajigur. 

3. Popular traditional food (still exist). 
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Popular traditional food groups are traditional foods that are still liked by the 

community with evidence that many are sold , and bought by consumers and 

some have even become icons of certain regions. For example, gudeg, melinjo, 

gatot, thiwul, bentuk tempeh, kipo, and klathak satay. 

 

 

 

2.5.2. Preserving Traditional Food 

 Traditional food is one of the most important national assets valuable. Its 

existence is very supportive of the development of tourism which is now highly 

encouraged, both domestically and abroad. Traditional food for the local 

community itself can be used as a regional identity.  

 Traditional foods, consumed by people over a long period of time, play an 

important role in establishing local identity, culture, and custom, and they transfer 

cultural heritage from generation to generation (Albayrak & Gunes, 2010) Which 

means that traditional food consumed by the community for a long time plays a 

very important role in determining local identity, culture, and customs. These 

traditional foods transfer cultural heritage from generation to generation that 

should be preserved. 

 As for the obstacles faced to preserve traditional food according to Sandi 

(2015), include: 

1. The taste of traditional food does not meet the tastes of the younger generation, 

its appearance is less attractive due to being cooked too long. 

2. Not meeting quality and nutritional standards. 

3. Some foods must be served hot. 

4. Promotion and dissemination of information and development efforts are still 

limited. 

5. Lack of investors interested in developing traditional food products. 

6. Lack of public knowledge about nutrition and health. 

 Based on the explanation of the preservation of traditional food according to 

several experts above, it is concluded that traditional food is a potential asset in 
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efforts to improve the nutritional quality of human resources because traditional 

food is consumed by the community for a very long time and plays an important  

 

 

role, these factors are the strongest determinants for determining eating habits and 

identity. an area and the need for preservation so that traditional foods do not 

become extinct traditional foods. 


